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Information in this document is subject to change 
without notice. No part of this document may be 
reproduced or transmitted in any form or by any 
means, electronic or mechanical, for any purpose 
without the express written consent of Information 
Integration Group. Inc. 
 
TRADEMARKS 
 
MS-DOS and Windows are trademarks of Microsoft 
Corporation. 
 
MAS 90, MAS 90CS, MAS 90W and MAS 200 are 
registered trademarks of Sage Software, Inc. 
 
All other product names and brand names are 
service marks, and/or trademarks or registered 
trademarks of their respective companies. 
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Installation Instructions and Cautions 

PLEASE NOTE: MAS 90 must already be installed on your 
system before installing any IIG enhancement. If not already 
done, perform your MAS 90 installation and setup now; then 
allow any updating to be accomplished automatically. 
Once MAS 90 installation and file updating is complete, you may 
install your IIG enhancement product by following the procedure 
below. 
 

Wait! Before You Install – Do You Use CUSTOM OFFICE? 
THIS IS AN IMPORTANT CAUTION:  If you have 
Custom Office installed, and if you have modified any MAS 
90 screens, you must run Customizer Update after you do 
an enhancement installation.  
 
But wait! BEFORE you run Customizer Update, it is very 
important that you print all of your tab lists. Running 
Customizer Update will clear all Tab settings; your printed tab 
list will help you to reset your Tabs in Customizer Update. 
Custom Office is installed on your system if there is an 
asterisk in the title bar of some of the screens. The asterisk 
indicates that the screen has been changed. 
 
 
 

         

An asterisk in a 
window’s title bar 
indicates that the 
screen has been 
modified. This 
means that 
Custom Office is 
installed. 
 
Follow all the 
instructions on 
this page before 
you run 
Customizer 
Update! 
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Registering IIG products 

IIG Enhancement should be registered to be able to use it. 
If registration is not performed, the enhancement will work 
in a demo mode for a limited time period. The registration 
can be still done during the demo period. 
 
Select the IIG Product Registration program under the 
Library Master Setup menu of the MAS 90. 
 
If this option is not listed under the Library Master Setup 
menu, go to the main menu, and select Run from the File 
menu. Type in SVIIGR and click OK. 
 

 
 
Enter Serial Number and Unlocking Key provided by IIG, 
and click OK. 
 
If multiple IIG Enhancements are installed, Serial Numbers 
and Unlocking Keys should be entered for each 
enhancement. 
 
Use the Print Registration Form button to print   
IIG Registration Form. 
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ODBC Security 

 
After installing an IIG Enhancement; it is very important 
to verify whether or not the Enable ODBC Security 
within Role Maintenance check box is selected in the 
System Configuration window of your system. If it is 
selected you must assign ODBC security permissions and 
allow access to custom data tables/fields for the Roles 
defined in your system. 
 

 
 
 

Role Maintenance 

 
After installing an IIG Enhancement, permissions must be 
configured for newly created Tasks and Security Events. 
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Introduction 

IIG Warehouse Shipping Automation with CPS/Malvern 
provides all the features needed to automate and improve 
the shipping processes. IIG Warehouse Shipping 
Automation with CPS/Malvern provides seamless integration 
of CPS, Malvern, Clipper ship, Scancode, and 
FedEx FXRS Ship Manager shipping solutions into Sage 
MAS 90 and 200, providing you the flexibility to adapt 
your business and customer shipping needs. 
It works also with IIG Credit Card Processing and Point Of 
Sale - Fast Sale enhancements. 
 
WARNING: 
If IIG Credit Card Processing (CCP) exists in the system, 
the installation order must be the following: 
 
1.CCP 
2.WSA 
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Shipping Automation Setup 

Sales Order Options 
Once the installation of the Warehouse Shipping 
Automation enhancement module is complete, allow the 
program to automatically perform proper system updates, 
conversions and self-settings upon first launch. From the 
Sales Order Setup menu, select the Sales Order Options 
program. 
 
Make sure the Enable Shipping box is checked on the 
Main tab. 
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Shipping Automation Options 
Select Shipping Automation Options under the Sales 
Order Setup menu. While running the Shipping 
Automation Options for the first time the system will set 
default data. 
 

 
 
A warning is displayed, if there is no Shipping Terminal 
configured. Terminals are configured in the Shipping 
Terminal Maintenance under the Sales Order Setup 
menu. 
 
Check the Charge Actual Freight? box if the actual 
freight amount will be invoiced. Checking this box enables 
the following two options: 
 
Zero Invoice No Charge?  Check this box to allow zero 
dollar invoices to not be charged freight. This is most 
commonly used with "no charge" replacement invoices. 
 
Prepaid Freight Allowed?  Check this box if allowing 
freight charges to not be charged. 
 
Check the Charge COD Fee Extra box if the COD fee 
should be added to the invoice freight amount. This amount 
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is calculated based on the carrier, when not Charging 
Actual Freight. 
 
Check the Charge Handling Fee? box if the customer will 
be charged for the handling of the package. Enter the 
amount the customer will be charged. Select the Per Parcel 
checkbox to specify that the handling fee that was entered 
will be applied to each individual parcel. If the Per Parcel 
checkbox is not selected, the handling fee that you entered 
will be applied to the entire shipment, regardless of how 
many individual parcels it contains. 
 
Note: The handling fee will be added to the invoice freight 
amount. 
 
Check the Default Declared Value? box to attach a 
declared value based on the invoice amount. Leaving this 
option unchecked will not apply a declared value to the 
shipment. 
 
Check the Default Signature Required box to turn on the 
Signature Required box in IIG Manifesting as the default 
per shipment. 
 
Check the Require Box Distribution box to forbid 
distribution of additional boxes when manifesting. The box 
distribution will be limited to the boxes entered in the 
Shipping Data Entry. 
 
Enter A/R Terms Code for COD and COD "Secured 
Funds" shipments. These terms specify to the system 
whether a COD shipment requires cash only or if a check is 
acceptable. 
Note: The Terms Codes for “COD” and “COD "Secured 
Funds"” should be created in the Accounts Receivable 
Terms Code Maintenance before the Terms Code may be 
used here.  
 
In the Export group, you can enter Export License, 
License Expires, and Shipper EIN. 
 
If the following on-line carrier programs: CPS 
(Computerized Parcel System), CLIPPERSHIP, FedEx 
PowerShip, or Malvern Site Server are installed, select 
the corresponding check boxes in the Shipping 
Automation Options screen.  
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Check the Close Manifest by Batch box to be able to close 
the manifest by the specified Batch Number. In this case 
you can add new shipment to the selected batch number 
after closing the Manifest. You cannot add shipments to 
any batch in case the Manifest has been closed for all 
batches. 
 
If the Subtract B/O Qty from Qty to Ship box is checked, 
the Qty to Ship is displayed instead of the Ordered 
Quantity in the Lines tab of the Shipping Data Entry 
program and it is calculated according to the following 
formula:  
  
Qty to Ship = Quantity Ordered – Backordered (data taken 
from the Sales Order).  
This option is functioning only for standard orders. 
 It is not available for Kit or Non-inventory items. 
The following message appears when trying to change this 
option while there is even one Shipping Batch in your 
system. 
 

 
 
  
If the Play WAV sound on some ship errors box is 
checked, WAV file will play if one of the lines has not been 
completely shipped. Otherwise, (if the box is unchecked) it 
will just beep.  
 
Calculate Ship Date from Ship Via Code?- this option is 
intended for calculating  the Ship Date of the Order taking 
into account the Lead Time in days value set for current 
Ship via code in the IIG Carrier Maintenance. 
  
Note: Any WAV file can be used, but it must have 
IIG_SHIP_ERROR.WAV file name and be put in the 
\mas90\soa folder. If MAS200 is running, do the same for 
any workstation.  
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Enter the Maximum weight. This is the maximal weight  
per box for rating which will default to 60 pounds. This 
field is used in Sales Order Data Entry when the user 
wants to rate the ordered items. If the box weight exceeds 
this threshold, increment the box count and continue to 
accumulate in the next box number. 

 

Shipping Terminal Maintenance 
In the Shipping Terminal Maintenance screen, specify 
the workstations that will be manifesting shipments and 
options used for calculating carrier charges. 
 
At least one Terminal ID should be setup.  
 

 
 
Enter Terminal ID or click the Current Terminal ID 
button. 
 
Enter Description of the terminal. 
 
Enter Location of the terminal. 
 
The Scale Port is the ID number of the communication 
port to which the weight scale will be connected. 
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Enter the warehouse code from the Ship From Warehouse 
lookup. If this field is blank, the program will continue to 
use the warehouse code from the invoice header during 
Shipment. 
 
Note: The selected communication port will be used for 
reading the scale, when CPS is not installed.  Currently, 
only Weightronix scales are supported. 
 

 
Check the Auto Increment Quantity box to add to 
quantity automatically for the selected terminal. 
 
 
Note:  The following group of fields will only appear when 
the FedEx Powership Installed box is checked in IIG 
Shipping Automation Options. 
 
TWB Printer is the FedEx Label printer UNC share path 
for the FedEx Shipmanager Server to print the thermal label 
to.  We strongly recommend that the path assignments be as 
short as possible.  If at all possible, limit them to 20 
characters total. 
 

FedEx Interface Maintenance 
Select the FedEx Interface Maintenance program under 
the Sales Order Setup menu. 
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Enter Warehouse Code, or select it using the Lookup 
button. 
 
Enter a Shipper Address, Telephone number, and 
Contact person for each location. This information will 
appear on the shipping label. 
 
Upon clicking the COD Return Address button the FedEx 
COD Return Address screen is opened allowing the user 
to enter the COD Return Address information for the 
selected warehouse. 
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In this screen, you can use the Copy Shipper Address to 
COD Address button, to apply the same address. 
 
The Currency Code is used for International shipping. 
 
The Shipper Account Number and Master Meter 
Number are assigned by Federal Express. 
 
Enter the Release Auth. No. (Release Authorization 
Number), which will allow your shipments to be delivered 
without an adult signature.  You must have a signed release 
on file with Federal Express. 
 
Check the Use FedEx Printers? to enable the FedEx server 
to print directly to the shipping workstation label printer.  
The label printer is set up in the Shipping Terminal 
Maintenance. It is recommended that the path assignments 
be as short as possible (maximum: 20 characters). 
 
The Server IP Address should be assigned by the 
company’s System Administrator. This is the IP Address of 
the FedEx Powership server. 
 
The Powership Port Number is assigned by Federal 
Express. This identifies the TCP/IP port on the FedEx 
Powership server (usually 2000). 
 



Warehouse Shipping Automation 4.30 16 
 

 
INFORMATION INTEGRATION GROUP  877.475.4092 
457 PALM DRIVE  WWW.IIGSERVICES.COM 
GLENDALE, CA 91202 

IIG Carrier Maintenance 
Select the IIG Carrier Maintenance program under the 
Sales Order Setup menu. 
 

 
 
Here you can setup more advanced carrier options for the 
Shipping Codes defined in the Shipping Rate 
Maintenance program. 
You can add new Shipping Codes just from this screen. 
 
Depending on the Residential Only check box setting the 
system will perform checking when generating manifest 
and the user will be prompted to check and set the 
Residential Address flag on the Order. 
 

 
 
The Lead Time in Days field is intended for entering the 
number of days to be used when calculating the Orders’ 
Ship Date if the Calculate Ship Date from Ship Via 
Code? option is turned On in the Shipping Automation 
Options. 
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 Box Dimension Code Maintenance 
Shipping Automation allows the setup of codes for 
packaging types that are shipped on a regular basis. Select 
the Box Dimension Maintenance program from the 
Inventory Management Setup menu. 
 

 
 
For each Box Dimension Code, enter a description, box 
dimensions, and, if applicable, a Weight Factor (used to 
account for the weight of pallets). Box dimensions are in 
centimeters if the Metric Dimensions is checked, and the 
Weight Factor will be in kilograms.  Otherwise, this is 
inches and pounds. 
 
The Additional Handling can also be set. 
 
The Bill of Lading Description is set automatically and 
can be changed. 
 
The UPS Box Type Code is set for UPS identification. 
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Item Freight in the Inventory Maintenance 
The IIG Freight button added on the Inventory 
Maintenance screen allows the user to set some freight 
specific data such as Freight Class, Export Data, specifying 
the Packaging/Tare settings. 
Select the Inventory Maintenance program under the 
Inventory Management Main menu. Select an item. 
 

 
 
Upon clicking the IIG Freight button the IIG Item 
Freight Additional Fields screen is opened: 
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Upon clicking the Tare Processing button, the IIG Item 
Freight Packaging/Tare Fields screen is opened. 
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Enter the Each Tare, Inner Pack Tare, Case Pack Tare, 
Master Pack Tare and Pallet Pack Tare unit of measures 
and select the Box Codes. The Height, Length, Width 
fields will be populated with corresponding values set for 
the selected Box Code in the Box Dimension code 
Maintenance. Select the Default Tare to be used when the 
product is shipped for rating. 
Only one of these five check boxes can be selected as 
default. 
Refer to Shipping Rate Shop In Sales Order Entry for more 
details about the Item Freight Packaging/Tare fields.  
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Shipping Options in Customer Maintenance 
The Options button added on the Main tab of the 
Customer Maintenance screen is intended for specifying 
special shipping options for the selected Customer. 
Select the Customer Maintenance program under the 
Accounts Receivable Main menu. 
 

 
 
Click the Options button to specify the shipping options in 
the IIG Special Shipping Options screen: 
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Select the Billing Option. Choose from the following 
options: Shipper, Recipient, Third Party, Consignee, 
Freight Collect or Drop Ship.  
 
For all the selections except for Shipper the Payor Account 
Data fields are enabled. 
 
Check the Blind Ship? Option to use the customer’s bill to 
address as the return address for the shipment.  
Enter the Blind Ship To Code below for the customer’s 
warehouse or for double blind shipments. 
 
The Blind Ship? option setting and the Blind Ship To 
Code specified here are defaulted to the Sales Order and 
Invoice Data Entry. 
 
Select the Suppress Packing Sheet option to skip packing 
sheet printing from Shipping Data Entry. If this option is 
turned on the Quick Print button will be disabled in the 
Shipping Data Entry.  
 
Upon selecting the Suppress Packing Sheet checkbox the 
Print Custom Packing Sheet option and Packing Sheet 
Form Code field are disabled. 
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Select the Print Custom Packing Sheet option to make the 
Packing Sheet Form Code field enabled. It is necessary to 
select the Form Code to be used by default in the Packing 
Sheet Printing run from the Shipping Data Entry for the 
selected customer. If the Print Custom Packing Sheet 
option is selected the user cannot close the Shipping 
Options screen unless a form code is specified.  
 
 Note: the user must set up the custom packing sheet form 
in packing sheet printing before it is available for this field. 
 
The Packing Sheet Options set in the Customer 
Maintenance are defaulted to the Sales Order Entry and 
Shipping Data Entry. 
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Void Reason Code Maintenance 
The Void Reason Code Maintenance added under the 
Sales Order Setup menu is intended for entering Reason 
codes to be used when the transaction is voided. 
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Shipping Automation Activity 

Shipping Options in Sales Order Entry and Invoice Data 
Entry 
Below is mentioned example on Sales Order Entry. 
 
While creating a new sales order in the Sales Order Entry 
screen, shipping options can be specified by clicking the 
Ship Options button located on the Header tab of the 
Sales Order Entry screen. 
 

 
 
Click the Ship Options button to open the Special 
Shipping Options screen. 
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Depending on what  Ship Via Code is selected on the 
Header tab of the Sales Order Entry screen, the chosen 
shipping method will be displayed in the Ship Via fields 
within the Special Shipping Options screen. 
 
All of these settings are defaulted from the Shipping 
Options accessed (and, initially, set up) through the 
Accounts Receivable module’s Customer Maintenance 
screen. 
 
Select the Delivery Period from the drop-down list. 
Choose from the following three options: Weekday, 
Saturday, or Sunday delivery. 
 
Check the Residential Delivery? box if shipment is a 
residential delivery. 
 
Check the Inside Delivery? box if shipment is an inside 
delivery. 
 
Check the Signature Required? box if a signature is 
required at delivery. 
 
Select the Billing Option from the drop-down list. Choose 
from the following options: Shipper, Recipient, Third 
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Party, Consignee, Freight Collect or Drop Ship. For all the 
selections except for Shipper, enter Payor Account Data. 
 
Select the foreign Destination Country using the Lookup 
icon if the shipment is not being sent to a US destination. 
 
Select the appropriate Terms of Sale from the drop-down 
list, if this is an international shipment. 
 
In Invoice Data Entry, when the Order is manifested, the 
Ship Options button becomes disabled, otherwise it is 
always enabled. 
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Shipping Data Entry 
To start shipping, you must first open a manifest in either 
of the IIG/Sage Shipping/Manifesting or IIG Manifest 
Processing programs. 
 
Select the Shipping Data Entry program from the Sales 
Order Shipping menu. 
 

 
 
Select the Shipper ID and Order Number to be shipped. 
 
The program loads all the lines of the order. 
 
The Current Package field displays the package number, 
where the items are distributed currently. To change the 
current package, click the Next Package No. button. The 
items will be distributed to the new package. 
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Fast Case Processing enables easy way to distribute large 
quantities to large number of cases. 
 
The Fast Case Processing can be used for a line only once 
and only before accepting the entry. 
 
Clicking the Cases… button opens the Fast Case 
Generation for the selected line, if there is Quantity 
Shipped specified (and if the generation has not been done 
before): 
 

 
 
Enter the Quantity Per Case. Based on it the program will 
calculate the number of cases needed to generate for the 
Quantity Shipped. If the Quantity Shipped is not a 
multiple of the Quantity Per Case, the quantity remaining 
after distributing to the cases completely will be placed in a 
separate case (which will remain incomplete). 
 
Check the Include Case 1 box, to include the first case in 
the distribution being generated.  
 
If the quantity of the selected line has already been 
distributed before starting the Fast Case Generation, the 
program will clear the previous distribution. 
 
The generated distribution can be seen in the Item 
Packaging Maintenance. 
 
The Item Packaging Maintenance has been modified to 
allow more convenient parcel managing. 
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(In our example, each of the generated cases includes 5 
units of the item. The last one has the remaining from the 
division quantity of 4) 
 
The Cases… button will be disabled for that line on the 
Shipping Data Entry screen. 
 
When this screen is first entered, the parcels where product 
is allocated are shown in the Parcels list box, and any 
unallocated items are show in the Items on Order list box. 
Selecting a parcel line in the Parcels list box will display 
the contents of that parcel in the Package Contents list 
box. Moving the products from Package Contents to 
Items on Order allows those items to be allocated to other 
parcels. The parcel is deleted when moving all items from 
Package Contents for that parcel. 
 
 
The Next Parcel button generates the next available parcel 
number for the operator to allocate items to. This is 
disabled if there are no items to allocate. 
 
The Delete Parcel button is enabled when a parcel is 
selected. When a parcel is deleted, the items in that parcel 
are moved to the Items on Order list box for allocation. 
 
The Copy Parcel button is enabled when a parcel is 
selected and the items in the parcel are also in the Items on 
Order list box to allocate. Clicking it creates a new parcel 
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with the same items up to the quantity to allocate. For 
example: 
 
There are three items, each with a quantity of 5, and, of the 
three items, one item has only a quantity of three remaining 
to allocate; then pressing the Copy Parcel button will 
generate a new parcel with two items with a quantity of 5 
allocated, the third item with 3 allocated, and the fully 
allocated item is removed from the Items on Order list 
box. 
 
The Bulk Copy button does what the Copy Parcels does, 
but keeps going until all items are allocated from the Items 
on Order list box. This allows the operator to create a 
“template” box and copy it to allocate all items to boxes. 
This is especially handy in the apparel business, where it is 
not uncommon to have four to six different sizes in a box, 
and sixty boxes to process. 
 
The Accept button accepts and writes the parcel contents in 
the Package Contents list box. 
 
The Cancel button undoes changes made in the Package 
Contents list box. 
 
The OK button accepts and closes the dialog. A warning 
message will be displayed if there are unallocated items in 
the Items on Order list box, which will allow return to 
allocating boxes. 
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Go to the Shipping tab of the Shipping Data Entry. 
 
The Tracking button allows tracking item packages. 
 

 
 
Click the Tracking… button to open the Summary 
Package Tracking Maintenance screen. 
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The IIG Ship fields have been added to this screen. 
 
Click the IIG Shipping button on the Shipping Data 
Entry screen to proceed to IIG Manifest Generation. 
 
The IIG Ship fields on the Summary Package Tracking 
Maintenance will display information after accepting the 
Shipping. Select the shipping again, and click the 
Tracking… button: 
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When a Shipping Data Entry is accepted, an invoice is 
generated. The Number of invoice is the same as the 
Number of Shipping. 
 
The shipping information can be viewed by clicking the 
Tracking button on the Header tab of the Invoice Data 
Entry screen. 
 
Shipping information cannot be modified in the generated 
invoice. 
 
Generated invoice cannot be deleted from Invoice Data 
Entry. The Shipping should be deleted instead (which will 
delete the invoice, too). 
 
If the order is already manifested, its shipping cannot be 
opened in the Shipping Data Entry program, until the 
order is removed from the Manifest. 
 

 
 
Clicking OK opens the Manifest to Void it, if necessary, 
after which the Shipping is opened. 
 

Manifest Processing 
Manifest processing features can be accessed through 
selecting the IIG Manifest Processing or IIG/Sage 
Shipping/Manifesting programs from the Sales Order 
Shipping menu. 
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Manifest Generation/Shipping allows user to create a 
Shipping Data Entry, and proceed to Manifest 
Generation. 
 
Selecting the Open Manifest option will set all proper files 
to begin shipment manifesting. 
 
New Manifest cannot be opened until the current manifest 
is closed. 
 
Click the Proceed button. 
 

 
 
When the manifest is opened, select the Manifest 
Generation option and click Proceed to generate manifest 
for sales order. 
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Select an Order, and enter Total Parcels number. 
The Customer No. field displays the customer specified for 
the selected order. 
 
You can view/edit Shipping Options and view Ship To 
Address information by clicking the corresponding 
buttons. 
 
Select the Box Code and enter the Ship Weight for the 
current Parcel. 
 
You can facilitate entry of the parcels by clicking the Load 
Weights button. 
 
The IIG Bulk Parcel Processing screen will be opened. 
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The Total Parcels and Total Weight values are displayed 
from the Manifest and can be changed here. 
 
The Allocated Wt. displays sum of the weights of already 
allocated parcels. 
 
To allocate multiple parcels at once, in the Parcel 
Template part, enter Parcel Weight, select Box Type, and 
enter the Number of Cartons to Generate. 
 
Click the Generate button to generate parcels with the 
selected settings. 
 
The Total Allocated Parcels displays the number of 
already allocated parcels. 
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You can create parcels for the weight not allocated yet by 
selecting the Box Code and clicking the Split Evenly 
button. The program will automatically create the necessary 
number of parcels of the selected Box Type to allocate the 
remaining weight (the difference of the Total Weight and 
Allocated Weight). 
 

 
 
All the fields on the screen become display-only after 
splitting the weight. 
 

 
 
Return to the IIG Manifest Generation screen to view the 
allocated parcels. 
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Click the SED button to enter the Shipper’s Export 
Declaration information.  
 

 
 
In the opened dialog box enter the FTSR Exemption and Federal XTN 
code. This information will be send to the carrier automation system (only 
CPS).  
 
Note: This will work only if the Shipping Interface is CPS, and the 
International Shipment? option is checked in the IIG Carrier Maintenance.     
 
The SED information will become display-only after manifesting.  
 
Click the Ship button to proceed. 
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Tracking Numbers are assigned to parcels.  
 
You can view the SED information after shipping by clicking the SED 
button:  
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You can use the Void button to delete an existing order 
manifest. 
 

 
 
It is necessary to enter/select the Reason Code while 
voiding the shipment. 
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The same IIG Manifest Generation program is available 
from the Shipping Data Entry program. 
 
After manifesting, the invoice printing contains information 
on shipment (Shipped via, Parcels, Boxes, Weights, 
Tracking Numbers). 
 
 

 
 
To close a manifest, run the Manifest Processing program 
under the Sales Order Main menu, select the Close 
Manifest option, and click Proceed. 
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A message is displayed asking for confirmation to close the 
manifest. The user is prompted to close carrier manifest 
first. 
 
Note: Closing Manifest will transfer all daily information 
to history after Daily Sales Journal/Update. That 
information will be available in the Invoice History Inquiry. 
 

  
 
The Close Carriers screen is opened allowing the user to 
select the Carrier Code (Service Type) to be closed prior to 
closing the Manifest: 
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Upon clicking the Proceed button the Close Manifest 
Report screen is opened to allow printing/reviewing the 
shipment information: 

 

 
 
The Voided shipments are printed with corresponding Void 
Reason Code: 
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After the report is printed the user is asked for confirmation 
to close the Manifest: 
 

 
After running the Daily Sales Update, select the Invoice 
History Inquiry program from the Sales Order Inquiries 
menu. 
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Click the IIG Tracking button to view the shipment 
information. 
 

 
 
Clicking the Tracking button also displays that 
information: 
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The Lines tab of the Invoice History Inquiry displays 
comment lines, added during the Daily Sales Update. 
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Daily Shipment Inquiry 
Daily shipments can be viewed through the IIG Daily 
Shipment Inquiry program in the Sales Order Inquiries 
menu. 
Only open manifests can be viewed through the Daily 
Shipment Inquiry program by selecting the Package 
Number. 
 

 
 
Click the Daily Totals button to view current information 
on all the packages of the day. 
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Shipment History Inquiry 
 
The closed manifests by Invoice Number can be viewed 
through the IIG Shipment History Inquiry program. 
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Invoices Not Manifested Report 
The Invoices Not Manifested Report program under the 
Sales Order Reports menu prints a list of the invoices 
shipped with the Shipping Automation system and not 
manifested yet. 
 

 
 
The Sales Journal cannot be updated until these orders are 
manifested or voided. 
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Invoices Without Tracking Numbers 
 
Select the Invoices Without Tracking Numbers program 
under the Sales Order Report menu. The program prints 
the list of invoices that do not have Tracking numbers. 
These can be invoices created without Shipping, invoices 
creating with shipping but not manifested. 
 

 



Warehouse Shipping Automation 4.30 52 
 

 
INFORMATION INTEGRATION GROUP  877.475.4092 
457 PALM DRIVE  WWW.IIGSERVICES.COM 
GLENDALE, CA 91202 

A/R Shipping History Report 
Select the IIG Shipping History Report program under 
the Accounts Receivable Reports menu. The program 
prints the list of invoices with their Tracking IDs. 
 

 
 
 
Here is an example of the printout without Invoice Detail 
Information: 
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This is an example of the printout with the Invoice Detail 
Information: 
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International Shipping History Report 
 
The International Shipping History Report has been 
added to the Sales Order Reports menu to allow printing 
the Invoices (from Shipping History) for the selected 
Shipment type. The following selections are available for 
Shipment: International, Domestic, Both. 
If International is selected only the Invoices with Ship 
Via code indicated as International Shipment in the IIG 
Carrier Maintenance will be included in the report.  
 

 
 
Selections by Country Code, State/Province Range, Date 
of Shipment, Ship Via and Zip Code are available.  
 
Here is a printout for International Shipping History 
Report: 
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The Invoices are printed with corresponding Tracking 
numbers. 
 
 

Shipping Rate Shop In Sales Order Entry 
The Rate Shop button added on the Totals tab of the Sales 
Order Entry allows rating the order. Upon clicking the Rate 
Shop button the system starts identifying how the product 
is shipped for rating. 
Rating is available only for Shipping Codes with Malvern 
Shipping Interface set in the IIG Carrier Interface 
Maintenance. 
 



Warehouse Shipping Automation 4.30 57 
 

 
INFORMATION INTEGRATION GROUP  877.475.4092 
457 PALM DRIVE  WWW.IIGSERVICES.COM 
GLENDALE, CA 91202 

 

 
 
Click the Rate Shop. button to determine the Rate for each 
Service Type. 
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The IIG Rate Shopping screen is opened allowing the user 
to select the Ship Via with corresponding Service Type, 
Carrier Code and Freight. 
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Upon the Ship Via selection, the corresponding Rated 
Freight is populated in the Rated Freight and Freight 
Amount fields. 
 
The purpose of this function is when the rating processing 
is working through the products on the order; many of their 
products are always shipped as separate box due to the 
dimensions of the item. 
 
So when the rating program is looping through the product 
ordered to determine what boxes the product can go into, 
these items will be treated as a separate box with nothing 
else in it.  The rating process will add the box factor to the 
item’s weight and use that (along with the dimensions) to 
generate a rating transaction. 
 
 
Products that are not always shipped as a separate box are 
added to the first box until the weight reaches the user set 
value in the Shipping Automation Options (Maximum 
weight per box for rating), which will default to 60 pounds. 
Once box weight exceeds this threshold, increment the box 
count and continue to accumulate in the next box number. 
 
Here is an example of how the Rate Shopping logic works 
in Sales Order Entry. The following 2 cases may occur: 
 

1. Products are shipped as separate box due to the 
dimensions of the item (these items will be treated 
as a separate box with nothing else in it). 
If Each UOM doesn't match and product is 
determined as separate box, the program will turn 
off the ship as one box logic. 

 
2. Products are not shipped as a separate box (such 

items can be added in the same box until the weight 
exceeds the value set in the Shipping Automation 
Options). 

 
1. Item shipped as one box 
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The Ship as One Box is set for 1001-HON-H252 Item. 
 
 

 
 
For selected “002” Box Code Weight Factor will be 3. 
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If the customer orders five of this item: 
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Rate shop showing five cartons at 65 pounds total. 
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The Formula of Weight for each item will be the following: 
 Item Weight  + Weight Factor    
 
If a widget is 10 pounds, and the box factor is 3 pounds, 
then: 
� Box 1 will be sent with dimensions 20 x 30 x 50, 

weight 13 pounds 
� Box 2 will be sent with dimensions 20 x 30 x 50, 

weight 13 pounds 
� Box 3 will be sent with dimensions 20 x 30 x 50, 

weight 13 pounds 
� Box 4 will be sent with dimensions 20 x 30 x 50, 

weight 13 pounds 
� Box 5 will be sent with dimensions 20 x 30 x 50, 

weight 13 pounds 
 
Adding the same item sold with FOUR U/M. 
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Rate shop now shows six boxes at 108 pounds, one at 43 
pounds, five at 13 pounds. 
 

 
 
 

2. Products are shipped as a separate box: 
 
Here is the sequence of steps how the program works: 

1. Determines what unit of measure is put in the Tare 
Processing screen in I/M Maintenance. 

2. Then the program checks to see if the product is 
shipped in the same UOM as defined in the Tare 
Processing screen (excluding EACH).  If it is, then 
boxes are generated for that line by the UOM. 

3. Checks for the default method of shipment. If there 
is sufficient product to meet that default method, the 
line is processed in the default UOM rather than in 
the largest UOM because that is the default. For 
example, if an item is 48 to a master pack, 96 on a 
pallet, and 12 to a case, and the case is marked as 
default, a shipment of 50 would be four cases and 
two each, instead of one master pack and two each. 

4. If not checked as one box and no default is set, the 
program will try to match the largest package to 
ship by. It will iterate down until it either hits each 
(if filled in), or if only cases are entered, the 
program will put the item back into the general 
weight pool until all other lines are processed.   
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Here is an example: 
 
The Ship as one box is not checked. 
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Same shipment of nine total units sold. 
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Same total weight, but now three boxes, 2 at 43 pounds, 
one at 13 pounds. 
 

 
 
The Formula of Weight for this item will be the following. 
UOM conversion factor * item weight + box factor 
 
If a widget is 10 pounds, and the box factor is 3 pounds, 
then: 
� Box 1 will be sent with dimensions 20 x 30 x 50, 

weight 4*10+3 = 43 pounds 
� Box 2 will be sent with dimensions 20 x 30 x 50, 

weight 43 pounds 
� Box 3 will be sent with dimensions 20 x 30 x 50, 

weight 10+3 = 10 pounds 
 
So the Default Box code (by unit of measure) and Ship as 
one box flags allow the rating transaction to determine 
what the freight is really likely to be. 
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Allow Ship Date Override in S/O Data Entry 

Role Maintenance 
 
The Allow Ship Date Override in S/O Data Entry 
Security Event has been added to the Role Maintenance to 
allow the whole corresponding functionality in the system 
if the check box is selected.  
 

 
 
Note: All this logic is provided also for Visual Integrator. 
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IIG Holiday Maintenance 
IIG Holiday Maintenance has been added under the Sales 
Order Setup menu to allow users fix their holidays. In the 
Holiday Date column specify the nonworking days and 
write descriptions in the Comment column.  
 

 
 
Lines for which the Weekend check box is selected are 
weekends. You can show/hide weekends by turning on/off 
the Hide Weekends.  
 
Filtering can be done by months by selecting corresponding 
Month number. 
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In the Cut Off Time field the end time of working day is 
fixed. 
Click on the Press for current Year button to display the 
records of current Year and Month. The current date is 
taken from GL Options. 
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Sales Order Entry 
Modification has been done is Sales Order Entry related 
to Holiday Maintenance. If a Ship Date is entered on the 
Header tab which is specified as holiday in IIG Holiday 
Maintenance a message is displayed asking to set the Ship 
Date to the next business day or not. 
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Shipping Automation Options 
 
The Calculate Ship Date from Ship Via Code? check box 
has been added to the IIG Shipping Automation Options 
screen. 
 

 
 
This option cannot be changed while the Recalculate S/O 
Ship Date Utility is in progress. The following message 
will be displayed: 
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The Lead Time in Days field has been added to the IIG 
Carrier Interface Maintenance. 
 

 
 
If the Calculate Ship Date from Ship Via Code? check 
box is not selected, the logic works as described. And if it 
is selected, the logic works by the following way: in Sales 
Order Entry when Ship Date is entered, that date is 
increased with the amount of days which has been specified 
in the Lead Time in Days field. Only after that the 
checking is performed related to Holiday Maintenance. 
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If 0 is set in the Lead Time in Days field, and the Order is 
created after the working day has been fixed (the hour 
specified in the Cut Off Time field in IIG Holiday 
Maintenance), 1 day is added to the ship date and after that 
checking is performed. 
 
Note: The Ship Date will not be recalculated when Ship 
Via field becomes blank. 
 
 

IIG Recalculate Sales Order Ship Date Utility 
 
The IIG Recalculate Sales Order Ship Date Utility has 
been added under the Sales Order Utilities menu. 
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Select the Sales Order(s) and for which you want the Utility 
to work and click the Proceed button. Scanning will be 
performed through the Sales Order Header file and Ship 
Dates will be recalculated based on the Order Date for 
Standard Orders that are not invoiced. 
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Click the Print button. 
 

 
 
The report displays the Orders that are being updated with 
their old and new Ship Dates. 
 

 
 
After closing the report the following message box will be 
displayed: 
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Printings 

IIG Shipping Label Printing 
The IIG Shipping Label Printing program has been added 
under the Shipping menu of the Sales Order module to 
enable Shipping Labels printing. 
 

 
 
Selections by Shipping/Invoice number and Warehouse 
Code are available. 
Here is an example of printout: 
 



Warehouse Shipping Automation 4.30 79 
 

 
INFORMATION INTEGRATION GROUP  877.475.4092 
457 PALM DRIVE  WWW.IIGSERVICES.COM 
GLENDALE, CA 91202 

 
 
Note: Paperless Office is provided for IIG Shipping Label 
Printing. It will work only if the PDF Directory field is 
specified and Invoice is selected as Document in the Form 
Maintenance of PL module. 
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IIG Pallet Labels Printing 
The IIG Pallet Label Printing program has been added 
under the Shipping menu of the Sales Order module to 
enable Pallet Labels printing. 
 

 
 
Selections by Shipping/Invoice number and Warehouse 
Code are available. 
Here is an example of printout: 
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Note: Paperless Office is provided for IIG Pallet Label 
Printing. It will work only if the PDF Directory field is 
specified and Invoice is selected as Document in the Form 
Maintenance of PL module. 
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Voided Shipments Report 
 
The Voided Shipments Report has been added to the 
Reports menu of the Sales Order module to allow printing 
the shipments that have been voided while the IIG Manifest 
is open.  
 

 
 
After the Manifest is closed no data is available for 
printing. 
Here is an example of printout: 
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Batch Invoice Transfer Utility 

The Batch Invoice Transfer Utility program added under 
Sales Order Shipping menu allows moving an Invoice 
from one batch to another. 
 

 
 
Select a line in the first grid then click the Copy button to 
move it to the second one. 
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IIG Freight Fields Update Utility 

The IIG Freight Fields Update Utility menu item has 
been added to the Inventory Management Setup. 
 

 
 
Select the NMFC Code, Sub Class or/and BOL 
Description check boxes and specify the range below. 
 
NMFC Code – makes the field uppercased. 
 
Sub Class – If the number specified in the Sub Class field 
does not belong to the fixed values, the program changes it 
to the one specified here. Here is the list of the values: 
"50|55|60|65|70|77.5|85|92.5|100|110|125|150|175|200|250|3
00|400|500|". 
 
BOL Description – Makes the Bill of Lading (BOL) 
description field uppercased, and limits to 30 characters. If 
blank, no change occurs to the item's BOL description 
field. 
 
Harmonized Tariff Code – Enter the Harmonized Tariff 
Code for specified item(s). Harmonized Tariff Code field 
uppercased, and limits to 15 characters. If blank, no change 
occurs to the item's Harmonized Tariff Code field.  
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Upon clicking the Proceed button the IIG Freight Fields by 
Range Utility Log printing screen is opened allowing the 
user to print/preview the changes prior to applying them. 
 

 
 

 
 

 
 
Select Yes to update the Item Freight additional fields old 
values with the desired ones.  
Open the IIG Item Freight Additional Fields screen from 
Inventory Maintenance to see the updated values. 
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Appendix A: CPS Upgrade Procedure for 
2006 

1. Before you start the upgrade, close out Daily Entry on the master station and move to 
history.  Exit Daily Entry. 

2. Run CPS Tools. Select File > Rebuild > Structures. This will clean up any data 
corruption. 

3. While still in Tools, select File > Rebuild > All. This will rebuild the file indexes. 
Exit Tools. 

4. Back up the CPSW folder to another location. 
5. Install the CPS update CD.  For 2006 the CPS CD will have say 20060102A as the 

version number.  Click Accept on all of the prompts. 
6. When the installation completes, remove the CPS CD.  You may have to reboot the 

computer. 
7. Run Daily Entry. Click Accept to the various carrier service agreements. CPS may 

advise you that there is a service pack available. If so, then click yes to get the service 
pack.   

8. If Daily Entry does not advise you of the service pack at this point, then exit Daily 
Entry.  Go to Start > Programs > CPS for Windows > Update CPS.  The program will 
check for and install the current service pack.  Click Finish when the screen in the 
background appears.  After a few seconds the status display will go away. 

9. After the service packs are installed, run CPS Tools and select File > Rebuild > 
Structures.  Then select File > Rebuild > All.  Exit Tools. 

10. Run Daily Entry.  Allow it to come up, and then exit if there are no messages. 
11. If you don’t have any slave stations, you can skip steps 12 through 15. 
12. Now, do the slave stations, one at a time. Do not run anything on the Master station 

until each of the slave stations is completed. 
13. Install the CPS CD on the slave station.  It will do the installation, at the end of which 

it may advise you that the system must be commissioned.  Click okay and ignore this 
warning. 

14. Run Daily Entry.  Daily Entry on the slave station should detect there is a service 
pack to install from the master station.  It should install automatically like the service 
pack did on the main station.  Click Finish when the background dialog appears. 

15. Run Daily Entry on the slave station again.  If it comes up as ready, then exit and go 
on to the next slave station. 
 

Issues you may run into: 
� You must install as an administrator for the local machine. Otherwise, critical files 

and registry entries will not be updated. 
� UPS "Worldship" labels may not show the lower document tab when it was there 

before.  Contact CPS to help you correct this.  Advise the tech that you made a 
backup before you installed on the main system (you did do the back in step 4, didn't 
you?).  He will probably have you copy a file from the backup to resolve this issue. 
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� USB printer drivers for the Eltron Orion or the older UPS printers may be flaky.  You 
may need to upgrade to a current printer to use the USB printers. 

 
IIG Tech Support, original January 18, 2006, revised March 31, 2006. 



Warehouse Shipping Automation 4.30 90 
 

 
INFORMATION INTEGRATION GROUP  877.475.4092 
457 PALM DRIVE  WWW.IIGSERVICES.COM 
GLENDALE, CA 91202 

Appendix B: CPS settings 

The following settings should be done in CPS, on each 
workstation using CPS, to enable correct processing. 
 
In the Tools > Environment Variables: 
  
Set these options to YES: 
AUTOINCREMENT, 
BYPASSINVOICE, 
NOF5DVMLOOKUP, 
NOUPSDVMESSAGE. 
  
In the Tools > Setup > Optional Label Information:   
  
Label 1 - "Ref 1:" Field REF_1,  
Label 2 - "Ref 2:" Field REF_2 
 
 
For Residential, you must set up separate Ship Via codes 
for CPS to work correctly. 
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UPS Common Carrier Service  Code   Service 
Next Day Early A.M.    @@15   UPS 
Next Day Early A.M. Letter   @L15 
Next Day Air or Express    @@01 
Next Day or Express Letter   @L01 
Next Day Air Saver    @@13 
Next Day Air Saver Letter    @L13 
2nd Day Air A.M.     @@07 
2nd Day Air A.M. Letter    @L07 
2nd Day Air or Expedited    @@02 
2nd Day Air Letter    @L02 
3 Day Select Commercial    @@12 
3 Day Selected Residential   @R12 
Commercial Ground    @@03 
Residential Ground    @R03 
 

UPS Hundredweight Service 
 
Next Day Air     @@01   UPH 
Next Day Air Saver    @@13 
2nd Day Air A.M.     @@07 
2nd Day Air     @@02 
3 Day Select Commercial    @@12 
Commercial Ground    @@03 
Residential Ground    @R03 
3 Day Select Residential    @R12 
 

International UPS Shipment Service 
 
Express      @@66 or @@01  UPW 
Express Letter     @L66 or @@01 
Express 10 KG Box    @A66 
Express 25 KG Box    @B66 
Express Extended Area    @X66 
Express Extended Area Letter   @Y66  
Express Extended 10 KG Box   @C66 
Express Extended 25 KG Box   @D66 
Expedited     @@67 or @@02 
Expedited Extended Area    @X67 
Standard      @@68 
Express Plus     @@54 
Express Plus Letter    @L54 
Express Plus 10 KG Box    @A54 
Express Plus 25 KG Box    @B54 
Express Plus Extended    @X54 
Express Plus Extended Letter   @Y54 
Express Plus Extended 10 KG   @C54 
Express Plus Extended 25 KG   @D54 
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FedEx Domestic Service 
 
Priority Overnight Service    @@01   FEX 
Priority Overnight Letter    @L01   Note: No electronic  
Standard Overnight Service   @@13   upload available at   
Standard Overnight Letter    @L13   present for FedEx. 
First Overnight Letter    @L15 
2Day Service     @@02 
Express Saver Service    @@08 
 

RPS North America Service 
 
2 Day Air Guaranteed    @@01   RPS 
2 Day Residential     @R01 
3 Day Air Guaranteed    @@12 
3 Day Residential     @R12 
U.S. Commercial Ground    @@44 
U.S. Residential Ground    @R44 
Hawaii Deferred Air    @@44 
Hawaii Deferred Residential   @R44 
Hawaii Deferred Outer-Is    @@44 
Hawaii Residential Outer-Is   @R44 
Alaska Deferred Air    @@44 
Alaska Residential Deferred   @R44 
Alaska Rural Deferred    @@44 
Alaska Rural Residential    @R44 
PR Deferred Air     10 
PR Deferred Residential    R10 
Canada Ground     @@44 
Canada Residential Ground   @R44 
Mexico Deferred Air    @@44 
Mexico Deferred Residential   @R44 
Mexico Extended     @X61 
Mexico Extended Residential   @Z61 
 

USPS Domestic Service 
 
Express Mail     @@01   USP 
Priority Mail     @@02 
Parcel Post Machinable    @@03 
Parcel Post Non-Machinable   @@08 
Parcel Post Local     110 
Special Std. Mail (single)    @@12 
Express Mail Flat Envelope   @L01 
Priority Mail Flat Envelope   @L02 
 

SPD Domestic Service 
SpeeDee Ground     @@03   SPD 
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Appendix C: Clippership Carrier List* 

Carrier Code       Carrier Description 
 
 A01 Airborne Express *For all codes, enter a “C” 
 A02 Airborne Express Letter (minus quotes) in the Service  
 A03 Airborne Second Day Type field. 
 A04 Airborne Second Day Letter 
 A05 Airborne NAS 
 A06 Airborne NAS Letter 
 A07 Airborne Deferred 
 A08 Airborne Deferred Letter 
 A09 Airborne Express Zone 
 A10 Airborne Express Letter Zone 
 A11 Airborne Second Day Zone 
 A12 Airborne Second Day Letter Zone 
 A13 Airborne NAS Zone 
 A14 Airborne NAS Letter Zone 
 A15 Airborne Deferred Zone 
 A16 Airborne Deferred Letter Zone 
 B01 BAX Global Overnight 
 B02 BAX Global Overnight Letter 
 B03 BAX Global Second Day 
 B04 BAX Global Deferred 
 D01 DHL Worldwide Priority Express (Non-Doc) 
 D02 DHL Int'l Document Service (Package) 
 D03 DHL Int'l Document Service (Exp-Doc) 
 D04 DHL USA Overnight (Package) 
 D05 DHL USA Overnight (Exp-Doc) 
 F01 FedEx Priority Overnight 
 F02 FedEx Priority Overnight Letter 
 F03 FedEx Priority Overnight Pak 
 F04 FedEx Priority Overnight Box 
 F05 FedEx Priority Overnight Tube 
 F06 FedEx Standard Overnight 
 F07 FedEx Standard Overnight Letter 
 F08 FedEx Standard Overnight Pak 
 F09 FedEx Standard Overnight Box 
 F10 FedEx Standard Overnight Tube 
 F11 FedEx 2 Day 
 F14 FedEx Express Saver 
 F15 FedEx Overnight Freight (1 Day) 
 F16 FedEx Economy 2 Day Freight (2 Day) 
 F17 FedEx ES Distance Based Freight (3 Day) 
 F18 FedEx First Overnight 
 F19 FedEx First Overnight Letter 
 F20 FedEx 2 Day Letter 
 F21 FedEx 2 Day Pak 
 F60 FedEx International First Letter 
 F61 FedEx International First Pak 
 F62 FedEx International First 
 F63 FedEx International Priority Letter 
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Carrier Code       Carrier Description 
 
 F64 FedEx International Priority Pak *For all codes, enter a “C” 
 F65 FedEx International Priority (minus quotes) in the Service  
 F69 FedEx International Economy Type field. 
 F71 FedEx International Priority 10KG Box 
 F72 FedEx International Priority 25KG Box 
 P01 USPS First Class Regular 
 P02 USPS First Class Presort 
 P03 USPS First Class Priority 
 P04 USPS Express ( PO to Address ) 
 P05 USPS First Class Priority Flat Rate 
 P06 USPS Express ( PO to Address ) Flat Rate 
 P32 USPS Standard A Bulk 
 P41 USPS Standard B Machinable 
 P42 USPS Standard B Non-Machinable 
 P43 USPS Standard B Intra-BMC 
 P44 USPS Standard B Destination BMC 
 P45 USPS Standard B Special 
 P46 USPS Standard B Library Rate 
 P47 USPS Bound Printed Matter ( single ) 
 P48 USPS Bound Printed Matter ( bulk ) 
 P60 USPS International Air Letter 
 P61 USPS International Air Small Packet 
 P62 USPS International Air Printed Matter 
 P63 USPS International Air Parcel Post 
 P64 USPS International Air Books/Music 
 P65 USPS International Air Periodicals 
 P66 USPS International Air Prnt. Mtr. M-Bag 
 P67 USPS International Air Bks/Music M-Bag 
 P68 USPS International Air Periodicals M-Bag 
 P69 USPS International Surf Small Packet 
 P70 USPS International Surf Printed Matter 
 P71 USPS International Surf Parcel Post 
 P72 USPS International Surf Books/Music 
 P73 USPS International Surf Periodicals 
 P74 USPS International Surf Prnt. Mtr. M-Bag 
 P75 USPS International Surf Bks/Music M-Bag 
 P76 USPS International Surf Periodical M-Bag 
 P77 USPS International Custom Express 
 P78 USPS International Demand Express 
 P79 USPS International Global Priority Std 
 P80 USPS International Global Priority Small 
 P81 USPS International Global Priority Large 
 R01 RPS Prepaid Air 
 R02 RPS Prepaid Ground 
 R04 RPS Prepaid Canada 
 R06 RPS Collect Air 
 R07 RPS Collect Ground 
 R09 RPS Collect Canada 
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Carrier Code       Carrier Description 
 
 R13 RPS Prepaid Ground Mexico *For all codes, enter a “C” 
 R17 RPS Multiweight Ground (minus quotes) in the Service 
 R18 RPS Multiweight Air Type field 
 R19 RPS Prepaid Europe 
 R20 RPS Multiweight Europe 
 R21 RPS Multiweight Mexico 
 R22 RPS Prepaid 3-Day 
 R23 RPS Collect 3-Day 
 R24 RPS Multiweight 3-Day 
 S01 Shipped With Other Goods (post shipment) 
 S02 Shipped With Other Goods (pre shipment) 
 U01 UPS Next Day Air 
 U02 UPS Next Day Air Letter 
 U07 UPS 2nd Day Air 
 U08 UPS 2nd Day Air Letter 
 U11 UPS Ground 
 U16 UPS GroundSaver 
 U20 UPS Hundredweight Ground 
 U21 UPS 3 Day Select 
 U24 UPS Hundredweight 3 Day Select 
 U25 UPS Hundredweight 2nd Day Air 
 U26 UPS Hundredweight Next Day Air 
 U35 UPS 2nd Day Air A.M. 
 U36 UPS 2nd Day Air Letter A.M. 
 U43 UPS Next Day Air Saver 
 U44 UPS Next Day Air Saver Letter 
 U45 UPS Hundredweight 2nd Day Air A.M. 
 U46 UPS Hundredweight Next Day Air Saver 
 U48 UPS Shipment Standard Service to Can 
 U49 UPS Shipment Express Service Intl 
 U54 UPS Shipment Expedited Service Intl 
 U60 UPS Early A.M. 
 U61 UPS Early A.M. Letter 
 U63 UPS Shipment Express Plus Service Intl 
 U64 UPS Express Service Intl 10KG Box 
 U65 UPS Express Service Intl 25KG Box 
 U66 UPS Express Plus Service Intl 10KG Box 
 U67 UPS Express Plus Service Intl 25KG Box 
 U68 UPS Express Service Intl Letter 
 U69 UPS Express Plus Service Intl Letter 
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Appendix D: FedEx Code & Service Fields 
List* 

Domestic (within the U.S.): Code Field = 001 
 
Service Field       Description 
 
1 Priority Overnight 
2 Priority Pak 
3 Priority Box 
4 Priority Tube 
5 Economy 2 Day Package 
6 Priority Letter 
7 Standard Overnight Package 
8 Standard Overnight Letter 
9 Economy 2 Day Pak 
0    Economy 2 Day Letter 
A    Overnight Freight Service 
B    Two-Day Freight Service 
C    First Overnight Letter 
D    First Overnight Package 
F    Express Saver Package 
G    Express Saver Freight 
H    Express Saver Pak 
I    Express Saver Letter 
 
 

U.S. Export Packages (International): Code Field = 051 
 
Service Field       Description 
 
1 International Priority 
2 International Priority Pak 
5 International Economy 
6 International Priority Letter 
A    International First Overnight 
B    International First Overnight Pak 
C    International First Overnight Letter 
D    FedEx 10 kg box 
E    FedEx 25 kg box 
 
 
 
* These Code and Service field designations are only applicable to FedEx Server. 
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